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SAFETY INSTRUCTIONS
In order to comply with current European safety regulations 
it is essential that the Naim loudspeaker connectors 
supplied with amplifiers and loudspeakers are used.

Do not under any circumstances allow anyone to modify 
your Naim equipment without first checking with the 
factory, your retailer, or your distributor. Unauthorised 
modifications will invalidate your guarantee.

Equipment must not be exposed to dripping or splashing 
and no objects filled with liquid, such as vases, should be 
placed on the equipment.

For your own safety do not under any circumstances open 
Naim equipment without first disconnecting it from the 
mains.

Warning: an apparatus with CLASS I construction shall be 
connected to a mains socket outlet with a protective 
earthing connection.

Where the mains plug or an appliance coupler is used as 
the disconnect device, the disconnect device shall remain 
readily operable. To disconnect the equipment from the 
mains remove the mains plug from the mains outlet.

The following label is attached to all mains powered 
equipment:

w arning    
This apparatus  

must be earthed

Note
To the fullest extent permitted by applicable law, Naim 
Audio Ltd. disclaims all liability for any loss or damages 
whether real, incidental or consequential that arise from 
using this product. Naim Audio Limited, its agents and 
representatives, cannot be held responsible for the loss of 
any data or content from a Naim/NaimNet server, however 
caused.
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Naim Audio products are conceived with performance as the top priority. Careful 
installation will help ensure that their full potential is achieved. This Reference Manual 
covers the HDX hard disk player. It begins with some general installation notes and 
statutory safety warnings. Product specific information begins in Section 4. A Quick 
Start guide is also included with the product.

Naim Audio products are subject to continual development and it is possible that 
this manual may not fully reflect the features and functionality of your HDX. For up to 
date information and the latest Reference Manual please visit www.naimaudio.com

Finally, as with any highly sophisticated technology, hard disk players and networks 
have their own terminology. Section 12 contains a glossary of hard disk player and 
network terminology that may help you get the best from this manual and ease the 
installation and operational learning curve. For additional support and technical 
documentation visit www.naimaudio.com 

Introduction

1 Connections

It is important for both safety and performance that 
any standard cables supplied are not modified.

1.1 Analogue Audio Interconnect Cables

If options are available with your equipment and 

installation, DIN interconnect sockets should be used in 

preference to Phono sockets. One end of each Naim 

audio interconnect cable is marked with a band to 

establish its correct orientation. The band denotes the 

end that connects to the signal source. Naim Hi-Line 

interconnect cables will provide the best results.

Audio interconnect plugs and sockets should be kept 

clean and free from corrosion. The easiest way to clean 

them is to switch off the equipment, pull the plugs out 

of their sockets, and push them back in again. Contact 

cleaners and “enhancers” should not be used as the film 

they deposit may degrade the sound.

2 Mains Power

Where fused plugs are used 13 amp fuses should be 
fitted. Fuses of a lower rating will fail after a period 
of use. Do not wire voltage dependent resistors or 
noise suppressors into mains plugs. They degrade the 
mains supply and the sound.

2.1 Mains Plug Wir ing

In some territories a mains plug may need to be fitted 

to the supplied mains lead. As the colours of the wires in 

the mains lead may not correspond with the coloured 

markings identifying the terminals in the plug proceed as 

follows:

The wire coloured GREEN-AND-YELLOW must be 

connected to the terminal in the plug marked by the 

letter E or by the safety earth symbol or coloured GREEN or 

GREEN and YELLOW.

The wire coloured BLUE must be connected to the terminal 

in the plug marked with the letter N or coloured BLACK.

The wire coloured BROWN must be connected to the 

terminal in the plug marked with the letter L or coloured 

RED.

2.2 Equipment Fuses

Mains powered Naim Audio equipment is fitted with a 

mains fuse on the rear panel adjacent to the mains input 

socket. Replace it if necessary only with the spare fuse 

supplied or with an identical fuse. Repeated failure of the 

fuse points to a fault that should be investigated by your 

retailer or Naim Audio.

2.3 Non-rewirable Mains Plugs 

If a non-rewirable plug is cut from a mains lead (for 

whatever purpose) the plug MUST be disposed of in a way 

to render it totally useless. Considerable shock hazard exists 

if the cut-off plug is inserted into a mains outlet.

2.4 Mains Circuits and Cables

A hi-fi system usually shares a mains circuit with other 

household equipment some of which can cause distortion 

of the mains waveform. This distortion can in turn lead to 

mechanical hum from mains transformers. Some Naim 

transformers are large in size, making them relatively 

sensitive to such distortion, and it may be necessary 

to take account of transformer hum when siting your 

equipment.

Transformer hum is not transmitted through the speakers 

and has no effect on the performance of the system; 

however, a separate mains circuit may reduce it. Such 

a circuit (ideally with a 30 or 45 Amp rating) will also 

generally improve system performance. Advice on the 

installation of a separate mains circuit should be sought 

from a qualified electrician.

Only use either the mains cable and plugs supplied or a 

Naim Power-Line mains cable.
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but sound quality will be progressively compromised as 

more elements of the kit are fitted. In situations of extreme 

radio interference Naim equipment may be unsuitable.

3.5 L ightning Precautions

Your Naim hi-fi system can be damaged by lightning and 

should be turned off and disconnected from the mains 

when there is risk of lightning. For complete protection all 

mains plugs and any aerial cables should be disconnected 

when not in use.

3.6 Problems?

Consumer protection varies from country to country. In 

most territories a retailer must be prepared to take back 

any equipment he has sold if it cannot be made to work 

satisfactorily. A problem may be due to a fault in the 

system or its installation so it is essential to make full use of 

your dealer’s diagnostic skills. Please contact your local 

distributor, or Naim Audio directly, if any difficulties cannot 

be resolved.

Some Naim equipment is made in special versions for 

different territories and this makes it impracticable to 

arrange international guarantees. Please establish the 

local guarantee arrangements with your retailer. Contact 

Naim Audio directly for help and advice if necessary.

3.7 Service and Updates

It is essential that repairs and updates are only carried 

out by an authorised Naim retailer or at the Naim Audio 

factory. Many components are custom made, tested 

or matched and appropriate replacements are often 

unobtainable from other sources.

Direct contact to Naim for service or update information 

should be made initially through Customer Services:

Tel: 	 +44 (0)1722 426600 

Email:	 info@naimaudio.com

Please quote the product serial number (found on its rear 

panel) in all correspondence.

Introduction

3 General Instal lat ion

Naim equipment is designed to offer the finest 
performance possible, avoiding compromise 
wherever practical. This can lead to circumstances 
that may be unfamiliar. The notes that follow contain 
advice specifically related to Naim equipment as 
well as more general warnings about the use of 
domestic audio products. Please read them carefully.

3.1 Si t ing The Equipment

In order to reduce the risk of hum audible from the 

loudspeakers, power supplies and power amplifiers 

should be located a reasonable distance away from 

other equipment. The maximum separation distance for 

connected equipment is that allowed by the standard 

interconnect lead.

Some Naim equipment is extremely heavy. Check the 

weight of the equipment prior to lifting and if necessary 

use more than one person so that it can be moved safely. 

Ensure that your equipment rack or table can easily 

support the weight and is stable.

3.2 Switching On

Source components and power supplies should be 

switched on before the power amplifiers. Always switch 

amplifiers off and wait a minute before connecting or 

disconnecting any leads. Always use the power switch on 

the product rather than a mains outlet switch.

A “thump” may be heard from the loudspeakers as power 

amplifiers are switched on. This is normal, will not cause 

any loudspeaker damage and does not point to any fault 

or problem. A mild “pop” may also be heard shortly after 

equipment is switched off.

3.3 Running In

Naim equipment takes a considerable time to run in 

before it performs at its best. The duration varies, but under 

some conditions the sound may continue to improve for 

over a month. Better and more consistent performance 

will be achieved if the system is left switched on for long 

periods. It is worth remembering however that equipment 

left connected to the mains can be damaged by 

lightning.

3.4 Radio Interference

In some circumstances, depending on where you live 

and the earthing arrangements in your home, you may 

experience radio frequency interference. Controls on 

broadcasting in some territories allow very high levels of 

radio frequency radiation and both the choice and exact 

siting of equipment may be critical. Susceptibility to radio 

frequency interference is related to the wide internal 

bandwidth necessary for high sound quality. A radio 

frequency filter kit is available for some Naim equipment 
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4 HDX Hard Disk Player Overview

The Naim HDX hard disk player will completely change the way you access and listen 
to your music collection. While the HDX may look like a CD player and can play CDs 
conventionally, it is intended to operate in a fundamentally different way.

• �Rather than simply reproducing the audio on a CD inserted in the drawer, the HDX 
automatically reads and stores the CD data for replay at any later time. The hard 
disk capacity of the HDX enables the data from approximately 650 CDs to be stored. 

• �In addition to its conventional analogue or digital audio outputs, the HDX can 
provide up to six NaimNet/StreamNet network streams for playback in multiple 
remote areas.

• �When the HDX first reads the data from a CD, it automatically accesses an internet  
music database and downloads the information held for that CD. The information 
can include title, tracks, artist, composer, genre and numerous additional details. 
This can then be used by the HDX to select or search for material and to build 
custom playlists. The CD cover artwork will also be downloaded if available and 
displayed by the user interface.

• �The HDX is able to operate as a conventional CD player. A CD inserted in the drawer 
can be played immediately with its audio routed to the analogue and digital audio 
outputs. Ripping a CD you don’t personally own constitutes a violation of copyright 
law. You must ensure if inserting a borrowed CD for playback that the HDX is not 
set automatically to rip the CD. Section 7.8.1 describes disabling and enabling 
automatic ripping.

The mode of control and operation of your HDX will depend upon the type of system 
with which it is integrated. These different “user interfaces” are introduced in Section 4.1 
while the most commonly used touch screen controlled Front Panel Display Interface is 
described in detail in Section 7.

If the HDX is your first experience of a network connected product you may find it 
worthwhile to read the glossary in Section 12 before moving on to installation and 
operation.

4.1 HDX User Interfaces

Unlike a conventional item of hi-fi equipment, the HDX can 

be operated in a number of different ways using a variety 

of user interfaces. The user interface you use to control 

your HDX will depend on the type of system in which it 

is installed and the ancillary equipment available. The 

following table and paragraphs carry short descriptions of 

each user interface.
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4.2.1 The Front Panel Display Interface

The HDX is most conveniently operated via its Front Panel 

Display Interface using either the front panel touch screen 

or the remote handset.

Note: The Front Panel Display Interface can also be 

configured to control any StreamNet compliant device 

connected to the network.

4.2.2 The External Display Interface

The HDX can be operated via its External Display Interface 

using the supplied remote handset (or a keyboard and/or 

mouse), in combination with an additional external display 

screen.The screen may be a monitor or TV with composite 

video, S-video or VGA input.

The External Display Interface is closely related to the Front 

Panel Display Interface and similarly provides access to 

HDX operational and setup features.

4.2.3 The NaimNet/StreamNet Touch Screen Interface

If the HDX is installed in a NaimNet home network, HDX 

network audio streams can be controlled from the 

NaimNet/StreamNet Interface. The NaimNet/StreamNet 

Interface can be accessed from a StreamNet compliant 

touch screen or a web browser. The interface can also 

control any StreamNet compliant device.

Note: The NaimNet/StreamNet Interface is not covered in 

this manual.

4.2 HDX Interface Options 

Interface	 Control 	 Display	 Notes

Front Panel Display	 Touch screen.	 Front Panel display.	 Enables control of both HDX local outputs in 	

 	 Remote handset.		  stand-alone installations and network streams in 	

 			   network connected installations.

External Display	 Remote handset.	 TV or monitor with VGA,	 Controls HDX local outputs only. 

 	 Keyboard/mouse.	 S-video or composite input. 

 	 USB touch-screen.	 USB touch screen.

Web Browser	 Flash enabled web browser.	 Duplicates functionality of Front Panel Display 	

 			   Interface or External Display Interface. Network 	

 			   connection required.

Desktop Client	 PC running Windows XP or Vista.	 Provides music database management and 	
 			   advanced HDX setup functions. Can also 	

 			   control local outputs. Network connection 	

 			   required.

NaimNet/StreamNet	 StreamNet compliant network touch screen.	 Controls network streams only. 

 			   Does not control local outputs. 

 			   Network connection required.

Note: An internet connection is required for detailed CD data lookup. Without an internet connection, limited information is 

available from a locally held database.

4.2.4 The Web Browser Interface

If the HDX is installed in a home network the External 

Display and Front Panel Display interfaces can be 

duplicated by any Flash enabled web browser

To access the External Display Interface from a web 

browser, open the web browser and type the unique 

“name” of your HDX into the browser address field. The 

name is the last four characters of the MAC address 

(excluding the colon separators) printed on the rear 

panel preceded by NSHDX). A typical “name” would be 

NSHDX4567.

To access the Front Panel Display interface from a web 

browser add the suffix:

/index.html?movie=fp.swf to the HDX name. 

E.g. NSHDX4567/index.html?movie=fp.swf

Note: Depending on your web browser you may need to 

type “http://” immediately before the HDX name.

4.2.5 The Desktop Client

If the HDX is installed in a home network that includes a 

personal computer running Windows XP or Vista, it can be 

operated via the Desktop Client Interface. The Desktop 
Client application provides the most comprehensive 

operational and search functionality. The Desktop Client is 
covered in Section 8 of this manual.

Some setup, file management and maintenance facilities 

are only available via the Desktop Client.
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5 Gett ing Started 

The HDX should be installed horizontally on a dedicated equipment stand intended for the 
purpose. Do not stand the HDX directly on top of another item of equipment. Ensure that 
the fan aperture on the rear panel is not obstructed. The HDX should be installed in its final 
location before connecting cables or switching on. Remember to install batteries in the 
remote handset.

The HDX can be connected to a computer network to retrieve album data and artwork 
from the internet, to stream music around the home using NaimNet hardware, or to take 
advantage of one of its alternative user interfaces. If the HDX is to be used in a network it 
is important that the network is working when the HDX is connected and switched on.

Locally connected audio amplifiers should not be switched on before the HDX is switched 
on. The HDX power switch is located on the rear panel with a standby button located on 
the front panel. The front panel standby button extinguishes when the HDX wakes from 
standby. 

To begin installation first identify the rear panel network, audio output and mains input 
sockets, and connect the appropriate cables.

5.1 Internet/Network Connections

While the HDX can be used in “stand-alone” mode without 

any network connection, if its full capabilities are to be 

realised it requires connection to an “always on” internet 

service via an ethernet router/modem with a built-in 

firewall.

If the HDX is to be used in a NaimNet/StreamNet network 

audio system, the network connection also enables the 

HDX to communicate with other network devices and 

provides access to its alternative user interfaces.

The HDX is set up when originally shipped not to require 

any further network configuration but to connect to 

a network automatically (it uses DHCP by default). 

However, if your HDX has been previously used, its network 

configuration may have been altered leaving it unable to 

connect automatically. Contact your retailer, installer or 

Naim Audio directly if this appears to be the case.

Note: An HDX used in stand-alone mode and switched 

on without a working network connection will revert to 

an internal IP address only suitable for stand-alone use. 

To restore the default DHCP setup, switch the HDX off, 

connect the network and switch it on again.

5.1.1 Network Hardware

Wired network connection is strongly recommended for 

the most consistent and secure HDX operation. 

Ethernet-over-mains hardware may be used and provides 

a simple and convenient method of home network 

connection. However, depending on mains wiring factors 

specific to each home environment, the presence of 

network data on the mains supply may compromise 

overall system sound quality. If any sound quality 

compromise is found to be unacceptable, dedicated 

network cabling should be installed.

5.2 Power Supply Upgrade

The HDX can be upgraded through the use of an external 

Naim XPS or CD555PS external power supply to power its 

analogue circuits.

If an external power supply is to be used, the link plug in 

the rear panel of the HDX should be removed and the 

power supply connected in its place using an SXPS Burndy 

cable. See Diagram 6.3.

THE SXPS BURNDY CABLE ONLY MUST BE USED TO CONNECT 
THE XPS OR 555PS POWER SUPPLIES.

Both the HDX and the external power supply must be 

switched off when the link plug is removed and the Burndy 

connections are made. Switch on the external power 

supply first followed by the HDX.

5.3 Audio Connections

Connect one or all of the analogue DIN (output 1) or 
Phono (output 2) output sockets, or the Digital output 

socket, to an appropriate audio system input. If using the 

analogue outputs use a Naim Hi-Line interconnect cable 

for best results.

Note: The output selector on the rear panel should be 

switched to reflect the analogue output connections used.

5.3.1 Signal Ground

Switch the HDX’s rear panel Signal Ground switch (see 

paragraph 6.2.14) to the Chassis position unless the HDX is 

connected in a hi-fi system incorporating another earthed 

source component, or mains “hum” is audible through the 

loudspeakers. Contact your retailer, distributor or Naim for 

advice if necessary.

Note: All Naim CD and DVD players are earthed so the 

Signal ground switch should be set to floating if one is 

connected in the system.

Note: “Connected” in this context means an analogue 

audio signal cable that includes an earth connection.



E6

Instal lat ion -  Gett ing Started

5.4 Switch On

If the HDX’s network facilities are to be used ensure that 
it is connected to a working internet connection before 
switching it on and that all the necessary peripheral 
equipment is appropriately connected and configured. 

Switch on the HDX using the rear panel power switch. 

After approximately one minute’s delay, the user interface 

Home menu will appear on the front panel touch screen 

(and any connected display). Navigate around the 

interface and select options by touching the screen or 

using the remote handset navigation (3456), ok, home 
and back keys.

Note: It is occasionally possible for the default remote handset 

command set to conflict with other remote controlled 

equipment in the home. A conflict will be apparent if the 

handset appears to control an unintended device or if 

another handset appears to control the HDX. If a conflict 

occurs the HDX handset command set can be changed. 

While pointing the handset towards the HDX, press and hold 

both the page down and input keys while simultaneously 

pressing the 2 or 3 key to change the command set. Press the 

1 key to return to the default command set.

5.5 External Screen Setup

If an external display is used, the HDX external display 

setup may need to be modified. Navigate, via the System 

menu, to the System Setup menu. Select and save the 

desired External Display Theme, External Display Aspect 
Ratio, External Display Mode and TV System. Initially disable 

the Screen Saver (found on System Setup page 1).

Note: The External Display Mode setting configures the 

external display for use with either an external touch 

screen or a remote handset. In touch screen mode, four 

shortcut buttons are displayed on the right of the screen 

that correspond to the home, browse, find and back keys 

on the remote handset. The on screen shortcut buttons 

can only be accessed from the touchscreen so are not 

shown in remote control mode.

Note: Once you have become used to the interface and 

are familiar with its functions the screen saver can be 

re-enabled. 

5.6 Fi rst  Use

The HDX is shipped with some music files already stored 

on its hard disk. One of these can be used to check that 

playback is operating correctly. Navigate via the Front 

Panel Display Interface from the Home Menu to the Quick 
Play menu and select Play Random to play a track.

To “rip” a CD to the HDX hard disk, use the front panel 

open button to open the CD drawer. Insert a CD and 

press the open button again to close the drawer. The 

ripping process will begin automatically. When CD ripping 

is complete the HDX will eject the CD automatically. See 

Section 10 for further information on ripping CDs.

Only CDs owned personally should be ripped. Ripping a 
borrowed CD may violate copyright law.

Note: Although the HDX contains a small internal music 

database, to be able to identify a CD and download its 

associated data during the ripping process, it must be 

connected to a working internet connection.

5.7 Software Upgrade

Software upgrade CDs will occasionally be released for 

the HDX. New software is installed simply by inserting the 

upgrade CD in the drawer. The software upgrade process 

will commence automatically. As part of the upgrade 

process the HDX will eject the CD and re-boot. The front 

panel display may also go blank temporarily. The upgrade 

process is complete once the display returns to the Home 

Menu.

Note: Any specific instructions included with the upgrade 

CD should be followed carefully.

Never switch off the HDX from the rear panel power 
switch or unplug it from the mains supply while a software 
upgrade process is underway.

5.8 Switching Off

Switching off the HDX from its rear panel power switch 

is not normally necessary unless it is to be un-installed. It 

can be put into standby mode by pressing the handset 

standby key or pressing and holding the front panel 

standby button for one second. The HDX may take up to 

one minute to enter standby mode during which time the 

standby button will flash. The standby button will remain lit 

when the HDX is in standby mode. Wait untill the standby 

button stops flashing and remains lit before switching off 

the HDX from the rear panel mains switch.

Note: If the HDX misses carrying out a scheduled automatic 

backup while in standby mode, the backup will take place 

when it is next switched on. Some hard disk operational 

noise may be heard while this takes place.

Never switch off the HDX from the rear panel mains switch 
or unplug it from the mains supply unless it is in standby 
mode.
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6 Gett ing Connected 

The HDX carries a variety of connection sockets on its rear panel. These are illustrated and 
described in the following diagrams and paragraphs. The numeric legends on the rear 
panel diagram refer to the numbered paragraphs in Section 6.2.

6.2 HDX Connections

6.2.1 Keyboard Socket

Optionally connect a PS2 format keyboard here to control 

the HDX in combination with an external display.

6.2.2 Mouse Socket

Optionally connect a PS2 format mouse here to control the 

HDX in combination with an external display.

6.2.3 VGA Interface

Optionally connect a VGA format screen here to display 

the HDX External Display Interface.

6.2.4 Serial Interface

For use if the HDX is to be integrated into an RS232 

controlled environment.

6.2.5 USB Interface Sockets 

USB control or audio source devices may be connected 

here. USB source devices can be made available across a 

network. 

6.2.6 Network Socket 

Connect to your network router here. The HDX requires a 

working internet connection with DHCP server.

6.2.7 S-video and Composite Video Sockets 

Connect an S-video or composite video screen (television) 

here for display of the HDX External Display Interface.

6.2.8 IR Input Socket 

Optionally connect an RC5 control signal here for local 

control of the HDX from an IR control repeater.

6.2.9 Coax and Optical Digital Audio Outputs

S/PDIF digital audio for connection to an audio system  

digital input. These outputs duplicate the analogue outputs.

6.2.10 Power Supply Upgrade

Enables the connection of an upgrade XPS or 555PS power 

supply. The link plug fitted must be removed. See Diagram 6.3.

THE SXPS BURNDY CABLE ONLY MUST BE USED TO CONNECT 
THE XPS OR 555PS POWER SUPPLIES.

Note: Both the HDX and upgrade power supply must be 

switched off when the link plug is removed and cable 

connections are made.

6.2.11 Output Selector

Selects output 1 (DIN), output 2 (phono) or both.

6.2.12 DIN Analogue Output (output 1)

Analogue output from the HDX for connection to a local 

audio system. Use this option if connecting to a Naim 

system.

6.2.13 Phono Analogue Output (output 2)

Analogue output from the HDX for connection to a local 

audio system. Use the DIN option in preference to the 

Phono option if connecting to a Naim system.

6.2.14 Signal Ground

Optionally disconnects and “floats” the analogue signal 

ground from the chassis earth. Select chassis unless the 

HDX is installed in a hi-fi system incorporating another 

mains earthed source component or mains “hum” is 

audible from the loudspeakers.

6.1 HDX Rear Panel

mains input 
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power 
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socket
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socket6.2.6
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6.2.9
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6.3 HDX Connected to XPS Power Supply

mains input 
and fuse

SXPS Burndy 
Cable

mains input 
and fuse

power 
switch

Cable
direction
marker

THE HDX REQUIRES MAINS POWER AT ALL TIMES - WITH OR 
WITHOUT AN EXTERNAL POWER SUPPLY.

THE SXPS BURNDY CABLE ONLY MUST BE USED TO CONNECT 
THE XPS OR 555PS POWER SUPPLIES.
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7 The Front Panel Display Interface

As introduced in Section 4, the HDX can be controlled via a number of different interfaces. 
This section covers the Front Panel Display Interface.

The Front Panel Display Interface is a graphical touch screen interface based on 
navigation around pages and selection of icons. The emphasis in this section is on the use 
of the interface via the touch screen although the supplied remote handset can also be 
used. The handset can also be used to operate Naim preamplifiers, integrated amplifiers 
and CD players.

The following paragraphs and illustrations describe how the Front Panel Display Interface 
is used to access some of the most often used HDX functions. Other functions can be 
accessed by following the same principles of interface navigation and selection. A 
navigation diagram showing the top levels of the interface can be found in Section 7.9. 
The remote handset is illustrated and its functions described in Section 7.10.

7.1 The Home Menu

The Home menu, illustrated below as it appears on the 

HDX front panel touch screen, is the menu from which all 

other interface menus can be accessed. Touch an option 

to select it. Touch the back button to return to the previous 

menu.

The icons stacked vertically on the right hand side of the 

menu provide short-cuts to the home (  ), browse (   ) and 

find (  ) menus, and the back (   ) button. These icons 

remain present in all menus and screens.

Selecting each of the options on the Home menu provides 

the following pages and functions.

Now Playing: Displays the track currently playing, its 

associated information and any associated artwork. 

Touching the Now Playing screen will also open a 

temporary, floating transport control window containing 

play/pause (  /  ), step backwards (  ), step forwards (  ), 

shuffle (   ) and repeat buttons (   ).

Note: If no track is playing the Now Playing information will 

be blank.

Browse Music: Provides access to the library of music 

stored on the HDX and on any network or USB connected 

storage media. See Section 7.2.

Find Music: Provides access to search functions that 

enable material stored on the HDX and on any network or 

USB connected storage media to be located. See Section 

7.3.

Ripping Monitor: Displays progress during ripping. See 

Section 7.4.

Current Playlist: Displays details of the tracks in the current 

playlist with options to clear the playlist, remove tracks, or 

save the playlist with a new name. If no user playlist has 

been selected, the tracks of the currently playing album 

will be displayed along with options to “remove” tracks 

and to save an edited version of the album as a playlist. 

See Section 7.5.

Playlists: Displays a menu showing all the saved playlists 

together with options to play, edit and delete. See Section 

7.6.

Quick Play: Selects a menu offering quick playback 

options. See Section 7.7.

System: Provides access to HDX system setup functions and 

status information. See Section 7.8.



E10

7.2 The Browse Music Menu

Selecting Browse Music from the Home menu will open the 

browse menu, illustrated below, and provide access to the 

library of tracks held either locally on the HDX or on any 

available network or USB storage device.

Albums: Displays an alphabetical list of material sorted by 

album. The menu also provides options of Play, Add (to a 

playlist), Tracks and Info.

Artists: Displays an alphabetical list of material sorted by 

artist. The menu also provides options of Play, Add (to a 

playlist), and Info.

Tracks: Displays an alphabetical list, illustrated below, of 

all tracks. The page provides options of Play, Add (to a 

playlist), and Info.

Note: The icon to the left of the track name indicates the 

file location - local (     ), USB (     ) or network (     ). 

Genres: Displays an alphabetical list of the genres assigned 

to albums. The menu also provides options to Play, Add (to 

a playlist), and Albums (within each genre).

Composers: Displays an alphabetical list of material sorted 

by composer. The menu also provides options to Play, Add 

(to a playlist), and Albums (by each composer).

Conductors: Displays an alphabetical list of material sorted 

by conductor. The menu also provides options to Play, Add 

(to a playlist), and Albums (by each conductor).

Performers: Displays an alphabetical list of material sorted 

by performer. The menu also provides options to Play, Add 

(to a playlist), and Albums (featuring each performer).

Music Location: Opens a menu, illustrated below, showing 

the music storage locations available to the HDX. Selecting 

one of the locations restricts browsing (or searching) to 

that location.

Note: If no external storage (USB or network) is connected 

this screen will not display. The interface will remain at the 

Local Server browse menu.

All Music - music stored both locally (on the HDX’s internal 

hard disk) and on all connected storage hardware. 

Local Server - music stored on the HDX’s internal hard disk. 

USB Music - music stored on locally connected USB devices 

(a memory stick for example). 

Network Music - music stored on network connected 

hardware (a network hard disk or a shared folder on a 

computer).

Selecting play from any of the Browse menus will clear 

the current playlist, play the selected item then display 

the Now Playing screen, illustrated below, showing the 

track playing, the artist, the album title and any available 

artwork. Touching the screen will then open a temporary 

floating transport control window containing play/pause 

(  /  ), step backwards (  ), step forwards (  ), shuffle (   ) 

and repeat buttons (   ).

Note: Selecting the handset Home key twice at any time 

will open the Now Playing screen.

Operation -  The Front Panel Display Inter face
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7.3 The Find Music Menu

Selecting Find Music from the Home menu will open 

a menu, illustrated below, providing access to search 

functions that enable music held either locally, or on any 

available network or USB device, to be found.

Tracks: Displays a menu, illustrated below, that enables an 

alpha-numeric search of tracks. Enter text to type a track 

name. Use the Search key to initiate the search.

Note: The handset numeric keys may also be used to enter 

text in a similar manner to mobile phone SMS text entry. 

Albums: Displays a screen that enables an alpha-numeric 

search of albums. Type an album name and use the 

Search key to initiate the search.

Artists: Displays a screen that enables an alpha-numeric 

search of artists. Type an artist name and use the Search 

key to initiate the search.

People: Displays a screen that enables an alpha-numeric 

search of people (performers, conductors etc.). Type a 

name and use the Search key to initiate the search.

Most Played: Displays a list of most played albums together 

with Play, Add (add the selected Album to a playlist), 

Tracks and Info buttons.

Last Played: Displays a list of last played albums together 

with Play, Add, Tracks and Info buttons.

Newest: Displays a list of newest (most recently ripped) 

albums together with Play, Add, Tracks and Info buttons.

7.4 The Ripping Monitor Screen

Selecting Ripping Monitor from the Home menu will open 

a page, illustrated below, that displays the HDX’s ripping 

activity. Ripping can be stopped by selecting the abort 
function or pressing the HDX front panel open button or 

handset open key.

7.5 The Current Playl ist  Screen

Selecting Current Playlist from the Home menu will open a 

page, illustrated below, that displays all the tracks in the 

current playlist. The tracks are displayed in the order in 

which they were added to the playlist. If a whole album 

was added, the tracks will play in the same order as they 

appear on the album. If the tracks of an album were 

added individually, or by creating a random playlist, they 

will appear in the order they were added regardless of the 

track order on the album they originally came from. The 

currently playing track is indicated by a      symbol.

Note: Selecting the handset Playlist key twice at any time 

will open the Now Playing screen.

List Jump: List Jump can be used to jump to a specific 

initial letter in a long list of items. For example, when 

browsing tracks, selecting List Jump will open a text entry 

window. Entering an initial letter and selecting search will 

return to the list and move the highlight bar to the first item 

starting with that letter.

Note: List Jump is only available when selecting the 

find (   ) shortcut from an item list screen.
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Select New Playlist followed by the OK button. A screen, 

illustrated below, will open that enables the new playlist to 

be named.

Name the new playlist by selecting text in a similar manner 

to mobile phone SMS text entry and touch the Save button. 

Selecting save returns the interface to the previous page. 

Selecting an additional item followed by Add opens the 

playlist selection window again where the newly saved 

playlist can be selected and addition of the item confirmed.

7.6.2 Selecting and Managing Playlists

Selecting Playlists from the Home menu displays a list of 

previously saved playlists together with options to Play, Add 

(add the selected playlist to the current playlist, an existing 

playlist or a new playlist), Tracks (tracks that make up 

the  selected playlist), Edit (change track order or remove 

tracks) and Remove (the entire playlist).

7.6 Playl ists

A playlist is a list of tracks collected together and saved with 

a specific name; “favourites” perhaps, or “party tracks”. 

Playlists are created by locating the desired items then 

adding them to either a new or existing playlist. An item 

may be a single track, a whole album, an entire genre or 

any group of items generated from a search. 

7.6.1 Creating, Naming and Saving Playlists

The procedure described below covers the creation of 

a new playlist by selecting items from the Browse menu. 

Items can however be added and playlists created or 

augmented from any menu that includes an Add button.

Selecting Albums, Artists, Tracks or Genres from the Browse 

menu displays a menu, illustrated below, that lists all the 

available items in the selected category.

To create a playlist, select the first desired item (Kite is 

selected in the illustration) followed by the Add button. 

Selecting the Add button will open the playlist selection 

window illustrated below.
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7.8 The System Menu

Selecting System from the Home menu will open the 

system menu, illustrated below, to provide house-keeping 

and setup functions. 

Assign Genres: Enables assignment of genres to locally 

stored albums.

Backup Monitor: The HDX automatically backs up locally 

stored material to a second internal hard disk. The back up 

monitor screen enables back-up progress to be monitored.

USB Devices: Displays a list of USB devices known to the 

HDX (i.e previously connected) and their connection 

status.

7.7 The Quick Play Menu

Selecting Quick Play from the Home menu will open 

a menu, illustrated below, that provides access to five 

playback short-cut pages.

Play Popular: Plays randomly from an automatically 

generated playlist of the most often played tracks.

Play Recent: Plays randomly from an automatically 

generated playlist of the most recently played tracks.

Play Newest: Plays randomly from an automatically 

generated playlist of the most recently ripped tracks.

Play Random: Plays tracks randomly selected from all those 

available to the HDX.

Random Playlist: Displays sequential menus from which 

genres, artists and albums can be selected. A random 

playlist will then be chosen from within those selections.

Network Shares: Displays a list of network devices known to 

the HDX (i.e previously or currently connected) and their 

connection status.

System Status: Displays the current HDX system status 

information. For example, the number of albums stored, 

the hard disk space available and current IP address.

System Setup: Provides acess to various HDX setup facilities. 

Sections 7.8.1 and 7.8.2 describes System Setup in detail.

Calibrate Screen: Enables calibration of the front panel 

touch screen or any USB connected external touch 

screens. Touch Calibrate Screen and follow the on-screen 

instructions.

Note: The HDX front panel touch screen is calibrated 

before shipping and should only be re-calibrated if 

operational inconsistency is suspected.

7.8.1 System Setup Page One

System Setup: Displays the current HDX setup and enables 

modification of a number of functional and display 

parameters. Two “pages” of setup parameters are present. 

Use the scroll bar to switch pages. The parameters on 

page one are illustrated and described in the following 

diagram and paragraphs. To change a parameter either 

select it and touch the change button, or double-touch 

the parameter. Once the system setup preferences have 

been configured they can be saved by touching the save 

button.

The clean button disables the touchscreen for 30 seconds 

so that it can be cleaned.

CD Mode: Switches the HDX between Auto Rip and 

Playback modes. In Auto Rip mode the HDX will 

automatically rip a CD inserted in its drawer. In Playback 

mode the HDX will automatically play a CD inserted in its 

drawer through its local audio outputs.

To play a CD in Playback mode, open the HDX drawer and 

insert the CD. The CD will begin playback automatically. 

The Current Playlist menu will list the tracks on the CD as if 

it were a playlist. Use either the handset transport keys or 

those in the Now Playing screen to play (  ), pause (  ), 

stop (  ), step forward (  ) or step backwards (  ).
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NaimNet Switch: Select to enable access to a NaimNet 

system if one is connected to the HDX. A NaimNet button 

will then be present on the right hand side of the interface 

display if a NaimNet system is available.

Screensaver: Sets the time before the screen saver 

activates.

Front Display Backlight: Sets time before the front display 

backlight automatically switches off.

External Display Theme: Selects the colour theme for the 

External Display Interface.

7.8.2 System Setup Page Two

The System Setup parameters on page two are illustrated 

below and described in the following diagram and 

paragraphs.

External Display Aspect: Selects the video aspect ratio for 

the External Display Interface.

External Display Mode: Selects the interface mode for the 

External Display (either touchscreen or remote handset). In 

Touchscreen mode the interface displays shortcut buttons 

that correspond to the home, browse, find and back keys 

on the handset.

TV System: Selects PAL or NTSC TV video modes for the 

external display.

Scroll Drag Mode: Selects Page and Initial letter modes 

for the display scroll function. With Initial Letter selected, 

screen scrolling is indicated by initial letters displayed at 

the top of the screen. With Page selected, screen scrolling 

is indicated by page numbers displayed at the top of the 

screen.

Operat ion -  The Front Panel Display Inter face

Network Shares
USB Devices
Backup Monitor
Assign Genres

7.9 Interface Menu Structure

The diagram illustrates the upper levels of Front panel 

display Interface menu and menu structure.

Home

Now Playing

Current Playlist

Ripping Monitor

Quick Play

Find Music

Newest
List Jump

Last Played
Most Played
People
Artists
Albums
Tracks

System

System Setup
System Status

Play Random
Random Playlist

Play Newest
Play Recent
Play Popular

Track information displayed with 
artwork and transport controls.

Displays track playing, and playback 
list.

Displays ripping progress information.

Browse 
Music

Music Location
Performers
Conductors
Composers
Genres
Tracks
Artists
Albums 

Playlists
Displays a list of previously stored 
playlists .

Calibrate Screen
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7.10 Handset Functions

Navigating around and selecting options 

in the Front Panel Display Interface can 

be done with seven primary handset keys: 

Navigation (3456), ok, back and home. 
These keys are highlighted in the diagram 

annotations.

Standby: �Switches to standby or wakes 

hardware. Ensure the handset 

is in the appropriate mode 

(hdd for HDX).

Mode: �Switches handset mode 

to preamplifier/integrated 

amplifier (pre), CD player (cd), 
or hard disk player (hdd).

Numeric: �Enable numeric or text entry 

for track selection or search.

Delete (del):	� Enables deletion of the last 

numeric or text entry.

Shift (  ): �Shifts text entry to upper case.

Output (out):	� Selects local outputs on 

appropriately equipped 

products (not HDX).

Volume: �Volume up (5) and down 

(6) for preamplifier or AV 

processor. These keys function 

regardless of the handset 

mode.

Mute:  �Mutes the preamplifier or AV 

processor audio output. These 

keys function regardless of the 

the handset mode.

Info (  ): �Displays information about the 

currently selected item.

Page: � �Selects the next (6) or 

previous (5) interface menu 

page.

Navigation:	 Navigates around and selects 

(3456)	 menu icons.

ok:		 Confirms icon selection.

Back: Steps back one interface menu.

Home: Selects the Home menu.

Browse: �Selects the Browse menu.

System: Selects the System Setup menu.

Find: Selects the Find menu.

Album: Selects the Album browse menu.

Artist: Selects the Artist browse menu.

Genre: Selects the Genre browse menu.

Playlist: Selects the Playlist menu.

Start (   ): Returns to the start of a track.

End (   ): Advances to the next track.

Stop (   ): Stops play. 

Play (   ): Begins play.

Rewind (   ):	 Fast reverse.

Forward (   ):	 Fast forward.

Repeat (    ):	 Repeats the current playlist.

Pause (   ):	 Pauses play.

Shuffle (    ):	 Randomises order of play.

Red Dot (   ):	�Triggers audio record on 

appropriately equipped products 

(not HDX).

Input: � Selects audio inputs on 

appropriately equipped products 

(not HDX).

Open: Opens the CD drawer.
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8 The Desktop Cl ient Interface

The HDX Desktop Client is an application that can be installed on a PC running Microsoft 
Windows XP or Vista. The PC must be connected to the network that incorporates the HDX. 
The application and its installer can be found on the CD packed with the HDX.

In addition to enabling control of HDX music playback, the Desktop Client interface also 
provides a variety of HDX setup and maintenance functions that are not available from 
any other interface.

To install the Desktop Client application insert the CD into the PC’s CD drive, double click 
on the Desktop Client icon and follow the on-screen prompts. Ensure that the HDX is 
switched on and connected to the network when the Desktop Client application is run.

The format of the Desktop Client interface and its operation will be familiar to those with 
experience of the Windows Explorer file browser application.

8.1 Connecting to The HDX

When first run, the Desktop Client application will scan the 

network to identify any connected Naim hard disk players. 

A window will open, illustrated below, listing the player or 

servers found and their IP addresses. Each player “name” 

listed is a shortened form of the MAC address printed on its 

rear panel.

If the Desktop Client has been previously connected to 

other network items (or to items with variable IP addresses) 

these may also be listed. Use the shortened MAC address 

shown in the name column to identify the HDX

If the HDX is not immediately listed, check that it is 

connected to the network and switched on, and click on 

Scan for Naim Devices.

Note: It can take as long as a minute for the HDX to “boot-

up” and become visible to the Desktop Client.

Select the name that refers to the appropriate hard disk 

player by clicking on it, and click OK. The selected hard 

disk player will now be connected to the Desktop Client.
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8.2 The Interface Screen

All Desktop Client functions are controlled via one main 

window. The window comprises a number of separate 

areas and tools distinguished by their application and 

context. The windows and tools are identified in Diagram 
8.3 and described in the following paragraphs.

8.3 Interface Windows and Elements

Transport controls (Section 8.4) 

Application menus (Section 8.5)

Now playing (Section 8.6)

Interface tabs (Section 8.7)
Simple Search (Section 8.10)

Music library network

Music library file detail

8.4 Transport  Controls

As well as providing stop, play/pause, fast forward, fast 
reverse, step forward and step reverse, the transport 

controls also include shuffle, repeat and auto rip/play 

buttons. The rip/play button switches the HDX between 

Auto Rip and Playback modes. In Auto Rip mode the 

HDX will automatically rip a CD inserted in its drawer. In 

Playback mode the HDX will automatically play a CD 

inserted in its drawer through its local audio outputs.

The shuffle function is applied to the current playlist while 

the repeat function can be applied to either single tracks 

or the current playlist. For more on creating and managing 

playlists see Section 8.13

8.5 Application Menus

The application menus comprising File, Edit, Action, View 

and Help provide a variety of tools and functions. They are 

described in the following paragraphs.

8.5.1 The File Menu

The File Menu provides network Connect and Disconnect 
commands, and application Exit command.

8.5.2 The Edit Menu

The Edit Menu provides file utilities (rename, etc.), copy 

and paste functions, select functions and access to file 

properties. 

8.5.3 The Actions Menu

The Actions Menu provides alternative access to play, 

queue and random play functions.

8.5.4 The View Menu

The View Menu enables selection of alternative interface 

views:

Player Mode view in which only the Transport Controls, 

Currently Playing Data and Application Menus are 

displayed.

Maintenance Mode view in which only the Music Library 

data and Music Library detail windows are displayed. 

Interrogation of the maintenance screens does not affect 

the track or playlist currently playing. 

Player and Maintenance view in which both modes are 

displayed. Diagram 8.3 shows the Player and Maintenance 

view.

8.5.5 The Help Menu

The Help Menu provides Desktop Client Application 

installation and version information.

8.6 Now Playing

The Now Playing field displays the artist, album, title and 

genre of the track currently playing.

Advanced Search (Section 8.10)



E18

Operation -  The Desktop Cl ient Inter face

8.7 Interface Tabs

The Interface Tabs serve to select one of three interface 

maintenance pages: Music Library, Tools and Now Playing.

8.7.1 The Music Library Tab

The Music Library tab selects the page illustrated in 

Diagram 8.3. The external storage hardware items to which 

the interface is connected (if any, beyond the HDX’s 

internal storage) are listed in the left hand window. They 

can be selected and their contents expanded by clicking 

on their associated + graphics. The display in the right 

hand window will then show the detail of music files stored 

on each hardware item. Clicking on the column headings 

will re-order the list of items sorted by the heading criteria.

8.7.2 The Tools Tab

The Tools tab selects the interface page illustrated 

in Diagram 8.8. It provides a set of hard disk player 

maintenance and setup utilities, listed in the left hand 

window, that can be selected and their contents 

expanded by clicking on their associated + graphics. 

Selecting a utility will open a dialogue box in the right 

hand window that either provides information, or can be 

used to specify a variety of hard disk player and network 

setup parameters.

Diagram 8.8 illustrates the Tools tab with all the utilities in 

the left hand window expanded and displays the Ripping 

Monitor utility in the right hand window. The full list of tools 

and utilities is described in Section 8.18.

8.8 Interface Tabs - Tools

8.7.3 The Now Playing Tab

The Now Playing tab 

selects the interface page 

illustrated in Diagram 8.9. 

The page displays the 

track currently playing, its 

associated information 

and the playlist in which it 

is included. 

The page also includes 

a text entry field for 

naming playlists and 

buttons for saving, 

shuffling (randomising) 

and clearing playlists. For 

more about creating and 

managing playlists see 

Section 8.13.

 8.9 Interface Tabs - Now Playing
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8.10 Simple and Advanced Search

The search tools of the Music Library page enable music 

files to be located for immediate playback or for addition 

to a playlist.

The simple Search tool illustrated in Diagram 8.3 enables 

searches to be carried out of either albums and artists or 

individual tracks. It is not necessary to type a full name or 

title in the search entry field although the more detail that 

is entered, the more fruitful a search is likely to be.

After entering the search text in the entry field and 

selecting either Albums/Artists or Tracks Only click on 

the Go button to initiate the search. The search results 

will be listed in the right 

hand Music Library page 

window. Double click 

on an item to play it 

immediately.

The Advanced Search 
tool enables a finely 

targeted search of music 

files to be performed. 

To begin an advanced 

search click on the 

Advanced Search button. 

A text entry window will 

open as illustrated in 

Diagram 8.11.

The advanced search text 

entry window enables two sets of search rules that can 

be configured to search for an album, artist, track, genre, 

composer, performer or conductor. Each rule can also 

be constrained to contain, begin with, match exactly, not 
contain or not match exactly the search text.

A search can also be constrained to match all or any of 

the search rules and carefully configuring the search rules 

should enable any specific music file to be found quickly.

For example, if a music library contained numerous 

Beethoven symphonies, but only versions conducted by 

Leonard Bernstein were required for playback, a search 

set up as illustrated in Diagram 8.12 would quickly find the 

appropriate music.

 8.11 Advanced Search

 8.12 Beethoven Search
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8.13 Playl ists

A playlist is a list of tracks arranged in a queue for 

playback. A playlist may be defined by the running order 

of an album, by selecting specific tracks or albums or be 

created by selecting tracks with the same, artist, genre, 

composer, conductor or performer. Playlists can be named 

and saved for later use.

To create, name and save a track playlist proceed as 

follows:

• �Click on the Music Library Interface Tab and then on 

the + graphic adjacent to the Albums thumbnail to 

expand the list of albums available to the server.

• �Select the album on which the first track required in 

the playlist resides and then select that track in the 

right hand window. Go to the application Actions 

menu and select Queue. Alternatively “right click” on 

the album and select Queue in the pop-up list.

• �Repeat the selection and queuing of tracks until the 

desired playlist is complete.

• �Click on the Now Playing Interface Tab. The queue 

of selected tracks will be displayed in the main 

window. To save the playlist, name it in the text entry 

field and click on 

Save. The playlist 

can be shuffled 

(randomised) or 

cleared by clicking 

on the appropriate 

buttons. Diagram 
8.14 illustrates 

saving a playlist.

Note: Clearing the current 

playlist does not delete 

tracks from the music 

library, it just removes 

them from the queue.

• �Once saved, the playlist can be recalled from the 

Music Library Interface Tab. Click on the + graphic 

adjacent to the Playlists thumbnail to expand the list 

of saved playlists then select the desired one. To play 

the playlist go to the application Actions menu and 

select Play.

 8.14 Save Playl ist
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8.15 Album Propert ies

The Desktop Client Application holds more information 

about specific albums than is displayed in the Player Mode 

or Maintenance Mode views. The information can be 

displayed by selecting the album’s properties. To access 

an album’s properties first right-click on the album name. 

A pop-up window will display as illustrated in Diagram 8.16. 

Note: As well as providing 

access to properties the 

right-click pop-up menu 

also provides access to a 

variety of other functions.

Clicking on properties 

displays the additional 

information for the album 

concerned as illustrated 

in Diagram 8.17.

 8.16 Selecting Album Propert ies

 8.17 Displaying Album Propert ies
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8.18 Tools and Ut i l i t ies

The Tools tab provides a set of hard disk player 

maintenance and setup utilities that can be selected and 

their contents expanded by clicking on their associated 

+ graphics. Selecting a utility will open a dialogue box in 

the right hand window that either provides information, or 

can be used to specify a variety of hard disk player and 

network setup parameters. The purpose and use of each 

tool and utility is described in the following paragraphs. 

Diagram 8.19 illustrates the full list of tools and utilities.

8.18.1 Ripping Monitor
Display real-time progress of CD ripping.

8.18.2 Ripping Alerts
Displays the server’s ripping log including any alerts.

8.18.3 Zone Maintenance
Enables network zone definition and maintenance.

8.18.4 Backup Monitor
Displays backup statistics and enables backup settings to 

be defined.

8.18.5 Backup Scheduler
Enables manual backups to be initiated and automatic 

backups to be programmed.

8.18.6 System Status
Displays various system status reports.

8.18.7 System Messages
Displays any system messages.

8.18.8 Lookup Messages
Displays any CD data lookup messages.

8.18.9 System Settings
Displays and enables editing of various system settings.

Note: The HDX internal clock and calender can be 

adjusted here.

8.18.10 System Functions
Provides image purge, database rebuild functions and 

version info. Only use if instructed to do so by Naim 

Technical Support.

8.18.11 Recycle Bin
Enables items within the recycle bin to be either purged or 

restored to the library.

8.18.12 USB Devices
Displays a list of current or previously connected USB 

devices.

8.18.13 Network Shares
Displays a list of current or previously connected network 

devices. 

 

 

8.19 Tools and Ut i l i t ies
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9 Playback

The HDX is able to provide simultaneously one local output and six network streams. The 
outputs you will employ from your HDX will depend on the type of system in which it is 
used. The following paragraphs describe the various output options and their context.

9.1 Local Playback

The HDX is fitted with the following local outputs:

• A single analogue output with switchable DIN and phono 

socket options.

• A single S/PDIF digital audio output with coaxial and 

optical socket options. The digital audio output is a 

duplicate of analogue output.

HDX audio outputs are intended to be connected to a hi-fi 

system or systems located either in the same area as the 

HDX or in nearby areas.

Selection of local playback can be made using the Local 

and Network Browser interfaces.

In addition to the CDs stored on the HDX’s hard disk, DRM-

free MP3, AAC, WMA, FLAC or WAV audio files stored on 

external storage devices can also be played by the HDX.

Note: Memory sticks connected via USB must be in FAT, 

FAT32, or NTFS format. Apple Macintosh formats are not 

compatible.

Note: Other playback file formats may be added as 

firmware updates in the future. Contact your Naim retailer 

or distributor for more information.

9.2 Network (streamed) Playback

The HDX is compatible with all NaimNet/StreamNet 

enabled devices. In addition to providing network-based 

remote control, NaimNet enables six unique streams of 

audio files to be delivered from the HDX for playback 

through NaimNet enabled output hardware in an almost 

limitless number of areas.

Note: Only 44.1kHz, 16 bit WAV or MP3 files identified and 

presented by an HDX will be available for streaming via 

StreamNet.
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10.1 The Ripping Process

Ripping CDs to the HDX is a simple process. It is preferable 

while ripping for the HDX to be connected to a working 

and reliable internet service.

Note: An internet connection is necessary for the HDX to 

identify CDs and download their artist, title, track listing and 

artwork data. If the HDX is unable to access the internet 

while ripping, it will initially interrogate a small internal 

database for the CD’s associated data. If the CD is not 

found on the internal database, only the ripped audio 

data and its identification code will be stored. Manual 

input of CD data or further AMG and FreeDB database 

requests can be made via the Desktop Client application 

once an internet connection is re-established.

Note: Right-click on the album name in the Desktop Client 

manually to request an online database lookup.

To rip a CD press the front panel or handset open button 

and place the CD on the drawer. Press the open button 

again to close the drawer. Ripping will begin automatically 

and takes up to eight minutes.

Note: It is good practice to check the playing surface of 

each CD is clean before ripping.

Note: Ripping can be cancelled once underway by 

pressing the HDX front panel open button or selecting 

Abort on the Front Panel Display Interface Ripping Monitor 

page.

When the HDX has ripped the CD and downloaded its 

associated data it will eject the CD automatically. As soon 

as a CD has been ejected, the HDX is ready to rip the next 

one. The Ripping Monitor menu provides feedback on 

progress as the ripping process takes place.

The CD will be included in the HDX’s music library listing 

about 1 minute after it has been successfully ripped. It will 

then be available for playback either locally or across a 

NaimNet network.

10 Ripping

The HDX will only fulfil its potential if it holds a significant library of music. A typical music 
CD carries approximately 600MB of data and the 400GB storage capacity of the HDX will 
hold approximately 650 CDs. Ripping a typical CD takes up to eight minutes thanks to 
the uniquely advanced data handling algorithms that ensure the ripped data is a “bit-
perfect” copy of the CD. 

10.2 Copyright Issues

The music carried on a CD, and the recording of the CD 

itself, is likely to be the subject of copyright restrictions 

which allow the owner of the CD only to make copies 

(ripping in effect copies a CD) for personal use only. 

Ripping CDs that you don’t personally own may violate 

copyright law.

Note: CD copyright law may vary with territory.
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Operation -  External Storage

11 External Storage

The HDX  is not only able to replay material ripped and stored on its internal hard disk but 
will also enable playback of material stored on a variety of externally connected storage 
hardware. Such hardware might be relatively small capacity units temporarily connected 
via one of the HDX’s USB interface sockets, or large capacity disk drives connected via a 
home network. 

11.1 Network Devices

Before material stored on a network device can be 

accessed by the HDX, it must scan the network to identify 

the address of each device and to build a database of 

the locations and details of the available audio files.

The HDX automatically scans the network when first 

switched on and will then periodically scan to find 

new storage hardware and identify any changes to 

the available audio files. It may however take up to 45 

minutes following connection of the HDX to the network for 

changes to be reflected in the HDX’s database.

Note: Network scanning is carried out at up to several 

hundred files per minute although this figure depends on 

the speed of the file storage device.

The tracks found by the HDX on network storage will be 

incorporated into its database and remembered until 

any changes are identified, irrespective of the HDX being 

switched off.

In order for network stored music to be available to the 

HDX, for network or local playback various conditions must 

be met:

• �Folders containing audio files must be set up to 

be “shared”. Refer to the folder’s host computer 

operating system user manual for details on setting 

up shared folders.

• �Music files must be in AAC, FLAC, MP3, or WAV 

formats (up to 24 bit, 96kHz only) for local playback, 

or WAV and MP3 at 16 bit 44.1kHz for both local and 

NaimNet network playback.

• �Music files must be unprotected by DRM encoding 

that restricts them to specific playback hardware.

11.2 Local Devices

A locally connected storage device will most likely be a 

memory stick connected to one of the HDX’s USB sockets.

Note: The amount of music stored on an external device 

determines how long the HDX will spend scanning the 

device when it is first connected before the music is 

available to browse.

Note: Locally connected devices are re-scanned every 

time the HDX starts up.

The tracks found by the HDX on locally connected storage 

will only be held in its database while the storage is 

connected and switched on.

Note: Local connection is only intended for relatively small 

music collections on temporarily connected memory sticks. 

Any large capacity storage should always be connected 

via the network.

In order for network stored music to be available to the 

HDX, for network or local playback various conditions must 

be met:

• �Music files must be in AAC, FLAC, MP3, or WAV 

formats (up to 24 bit, 96kHz only) for local playback, 

or WAV and MP3 at 16 bit 44.1kHz for both local and 

NaimNet network playback.

• �Music files must be unprotected by DRM encoding 

that restricts them to specific playback hardware.

Diagram 11.3 illustrates how music files stored on both 

locally and network connected hardware are displayed 

on the left hand side of the Desktop Client Music Library 

Tab. Selecting an item will expand the detail of its contents 

in the right hand window.

Note: In Diagram 11.3, the locally connected external 

storage device is a Freecom DataBar USB Device and the 

network storage hardware is a PC hard disk containing two 

shared music folders, “My Music” and “Party Music”.

11.3 Desktop Cl ient F i le Display
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12 Hard Disk Player Terminology

The following pages carry a glossary of hard disk 
player and network terminology that will help you get 
the best from this manual and ease the installation 
and operational learning-curve.

AAC: 
AAC (Advanced Audio Coding) is a lossy compression 

and encoding format for digital audio. Intended to be 

a successor of the MP3 format, AAC was designed to 

achieve better sound quality than MP3 at equivalent 

levels of data compression. AAC’s best known use is as the 

default audio format of Apple’s iPhone, iPod, and iTunes 

application, and as the format of all iTunes Store audio. 

AAC is however also employed by Sony and Nintendo. 

AAC files are sometimes identified by .m4a or .mp4 file 

extensions.

AMG: 
The All Music Guide database is the primary database 

that the HDX interrogates when a new CD is inserted in its 

drawer. The AMG database can be interrogated manually 

at www.allmusic.com

Note: The data provided by AMG is occasionally 

inaccurate or incomplete. It is possible however to submit 

corrections at www.allmusic.com

Broadband Internet: 
Broadband internet is the generic term for an “always-on” 

internet connection that provides data download rates of 

between 256kb/sec and around 8Mb/sec.  

Browser: 
A browser is a PC application that accesses, displays and 

implements web pages. Microsoft Internet Explorer and 

Mac OS X Safari are examples. As well as distributing music 

data on a network, the HDX generates web pages that 

can be read by a browser.

Client: 
A client is a software application on a PC that accesses 

a remote service on another computer system, known as 

a server, by way of a network - the HDX Desktop Client 

application for example.

DHCP (Dynamic Host Configuration Protocol): 
Hardware items installed on a TCP/IP network have an IP 
Address through which they are identified by all the other 

items on the network. DHCP is a set of rules that enable the 

automatic allocation of addresses as items are connected 

(or switched on while connected) to the network. The HDX 

is set up by default to use DHCP.

Digital Rights Management (DRM): 
Digital Rights Management refers to the data embedded 

in some music files that restricts copying and playback. 

Material downloaded from the Apple iTunes store is an 

example.

Firewall: 
A firewall is a network device or software application 

designed to control computer network traffic by 

compliance with a specific set of rules and security criteria.

Firmware: 
Firmware describes control and interface computer 

programs that are embedded in the electronic hardware 

of a product.

FLAC: 
FLAC (Free Lossless Audio Codec) is a file format for audio 

data compression. Being a lossless format, it removes no 

information from the audio data, as lossy compression 

formats such as MP3. FLAC’s primary advantage is a 

reduction of data storage requirements by up to 50% 

without sacrificing audio quality.

Flash: 
Adobe Flash is a software application that provides 

interactivity and animation in web sites. It is usually 

embedded into web browser applications.

FreeDB: 
FreeDB is the secondary database that the HDX 

interrogates when an unknown CD is inserted in its drawer.

Internet: 
The internet is the worldwide network of predominantly 

TCP/IP connected servers and computers. While the 

internet provides a variety of data services for professional 

and corporate use, most people know it for email and the 

World Wide Web.

IP Address: 
An IP address is a numerical identifier unique to a specific 

piece of hardware on a TCP/IP network. IP addresses 

contain four groups of numbers from 0 to 255 separated by 

dots. 192.168.0.8 is a typical IP address.

Local: 
Local in terms of this manual means non-network 

connections and associations. For example, a hi-fi system 

(amplifier and speakers) connected to the HDX’s audio 

outputs, or a touch screen connected to the HDX’s 

USB interface is local. A hi-fi system or a touch screen 

connected via the NaimNet network is not local.

Memory Stick: 
A memory stick is a small, portable solid-state computer 

memory element that connects via USB to provide 

removable extra storage. Memory sticks have replaced 

floppy disks.

Modem: 
A modem is an item of network hardware that forms a 

bridge between the network and the internet - usually via 

a broadband connection through telephone lines.

Glossary of Terminology
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Naim Extended Music Database: 
Thanks to the HDX’s use of the AMG database, it is able 

to access significantly more information than competing 

products. This means selection and searching for specific 

items can be more intuitive and productive.

NaimNet: 
NaimNet network enabled audio products are 

manufactured in the UK by Naim Audio. Like their closely 

related non-network Naim products, they represent the 

ultimate in musical performance.

Network: 
A network in terms of this manual is a group of 

interconnected and communicating servers, computers, 

or peripheral devices that are able automatically to share 

and control large volumes of data at high speeds.

Network Storage: 
If a CD collection is too large for the internal storage of the 

HDX, an external hard disk can be added to the network 

to increase the storage available.

Playlist: 
A playlist is a specific group of tracks collected together for 

a specific purpose; “favourites” perhaps, or “party tracks”. 

A simple list of tracks queued-up to play (the tracks of an 

album for instance) may also be referred to as a playlist.

Ripping: 
Ripping is the slang term for extracting and storing the 

audio data from a CD. The HDX is unusual in ripping the 

audio data repeatedly to minimise errors. There are some 

copyright and legal issues to consider when ripping CDs.

Router: 
A router is an item of network hardware that controls 

network traffic. Many home network routers include a 

broadband modem to connect the network to the internet 
and many also include a wireless element that enables 

network hardware with wireless capabilities to connect.

Server: 
Server is a generic term that describes an item of network 

hardware that stores and provides data to the network.

Shuffle: 
Shuffle is a term used to describe the random playback of 

tracks.

S/PDIF: 
S/PDIF (Sony/Philips Digital Interconnect Format) is a digital 

audio interface format commonly used in domestic digital 

audio equipment.

StreamNet: 
StreamNet is a proprietary network technology that 

enables synchronous and very high quality streaming of 

audio and video over TCP/IP networks. The HDX and all 

NaimNet products are StreamNet compatible.

Instal lat ion -  Terminology
TCP/IP: 
TCP/IP (Transmission Control Protocol/Internet Protocol) is 

the communications protocol on which the internet and 

many other networks ares based.

User Interface (UI): 
Different user interfaces are available with the HDX 

depending on the model and mode of use. See Section 

4.2.

USB: 
USB (Universal Serial Bus) is a computer interface format 

developed to enable simple connection of computer 

peripheral devices.

WAV: 
WAV (Waveform Audio Format) is a Microsoft/IBM audio file 

format for storing and transferring audio on PCs. WAV is a 

“lossless” file format.

Web Page: 
A web page is a computer screen full of data output by 

a network device that communicates information on its 

status and may enable control via a mouse and keyboard.

WMA: 
WMA (Windows Media Audio) is an audio data 

compression technology developed by Microsoft. The 

name can refer to both the audio file format and the 

audio compression technique itself.
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13 Commercial Acknowledgements

13.1 DigiFi  End-user L icense Agreement
USE OF THIS PRODUCT IMPLIES ACCEPTANCE OF THE TERMS 
BELOW.

This product contains technology from DigiFi LIMITED of 
London, United Kingdom (“DigiFi”). The technology from 
DigiFi LIMITED (the “DigiFi Embedded Software”) enables 
this product to rip, encode, store, manage and control 
digital music from compact discs owned by the user.  This 
digital music is stored in the DigiFi Database (the “DigiFi 
Database”). The software specified in this Licensing 
Agreement is and will be the sole property of DigiFi LIMITED. 
It is subject to copyright and as such is protected to the 
fullest extent allowable by law.

You agree that you will use the DigiFi Embedded Software 
for your own personal use only and that if this product 
is used in an environment where there is a risk of public 
broadcast of music or images stored thereon, that you are 
properly licensed to do so.

You agree that you will access the DigiFi Database only by 
means of the standard end user functions and features of 
this product.

You agree not to assign, copy, transfer or transmit the DigiFi 
Embedded Software to any third party.

You agree not to use or exploit the DigiFi Embedded 
Software, the DigiFi Database or any DigiFi component 
except as expressly permitted herein. You may not use 
the software in any way which threatens or violates 
the owner’s copyright. That includes making copies, 
reproducing, modifying, decompiling, reverse engineering, 
disassembling or making derivative products of the 
software or decoding it in any other way.

You agree not to use DigiFi Embedded Software for 
unauthorized duplication of CDs or any other works 
protected by copyright. No license to infringe copyright 
is granted by using DigiFi Embedded Software. Recording 
and playback of some material may require permission. 
For further information refer to the copyright owner.

You agree that your non-exclusive license to use the 
DigiFi Embedded Software will terminate if you violate 
these restrictions. If your license terminates, you agree to 
cease any and all use of the DigiFi Database, and DigiFi 
Embedded Software. DigiFi LIMITED reserves all rights in 
the DigiFi Embedded Software, including all ownership 
rights. You agree that DigiFi may enforce its rights under this 
Agreement against you directly in its own name.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
ALL DigiFi TECHNOLOGY IS PROVIDED “AS IS”, WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND/OR FITNESS FOR A PARTICULAR 
PURPOSE AND/OR NON-INFRINGEMENT. THE LICENSOR AND 
ITS SUPPLIERS SHALL NOT BE HELD LIABLE FOR ANY DAMAGE 
THAT MAY RESULT FROM THE USE OF DigiFi EMBEDDED 
SOFTWARE. THE LICENSEE USES DigiFi EMBEDDED SOFTWARE 
ENTIRELY AT ITS OWN RISK. IN NO CASE WILL DigiFi LIMITED 
BE LIABLE FOR ANY CONSEQUENTIAL OR INCIDENTAL 
DAMAGES.

14 Declarat ion of Conformity

Manufacturer �Naim Audio Limited, Southampton 
Road, Salisbury, England, SP1 2LN

Product HDX

Safety �EN 60065 - Audio video and similar 
electronic apparatus. Safety 
requirements.

EMC �EN 55013 - Sound and television 
broadcast receivers and associated 
equipment. 
EN55020 - Electromagnetic immunity 
of broadcast receivers and associated 
equipment. 
EN 61000-3-2 - Limits for harmonic current 
emissions. 
EN 61000-4-2 - Testing and measurement. 
Electrostatic discharge immunity.

13.2 StreamNet Acknowledgement

NetStreams’ patent-pending StreamNet technology 

provides an end-to-end IP ecosystem for plug-n-play 

connectivity, A/V signal synchronization, high performance 

A/V reproduction, automatic device discovery and 

configuration, network control, and more. All products that 

carry the ‘StreamNet Connected’ logo are interoperable, 

enabling easy integration of audio/video and control 

products from multiple manufacturers. StreamNet provides 

a stable, easily expandable platform and toolset for future 

products and new applications. 

www.streamnetconnected.com

13.3 Macromedia Flash Acknowledgement

Contains Macromedia® Flash™ technology by Adobe 

Systems, Inc. Copyright© 1995-2003 Adobe Systems, Inc. All 

rights reserved. Adobe Systems, Flash, Macromedia Flash, 

and Macromedia Flash Lite are trademarks or registered 

trademarks of Adobe Systems, Inc. in the United States and 

other countries.
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User Notes

Products that display the crossed-out wheeled bin logo 
cannot be disposed of as domestic waste. These products 
must be disposed of at facilities capable of re-cycling them 
and appropriately handling any waste byproducts. Contact 
your local authority for details of the nearest such 
facility. Appropriate recycling and waste disposal 
helps conserve resources and protects the 
environment from contamination.

15 User Notes

HDX Serial Number	

HDX MAC Address	

Display MAC Address

HDX Name

Use this section to record your HDX’s identification data 

for possible future reference. The Serial Number, HDX MAC 
Address and Display MAC Address can be found printed 

on the rear panel. The HDX Name can be found via the 

System Status page of the Front Panel Display Interface.

eg. 123456 (on rear panel)

eg. 1A:2B:3C:4D:5E:6F (on rear panel)

eg. A1:B2:C3:D4:E5:F6 (on rear panel)

eg. NSHDX5E6F 

(NSHDXxxxx where xxxx is last 4 digits of MAC Address)
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